
 

 
 
 
 
 

“How To…” Users Guide 
 
 
 
The UsedBoats.com “How To…” Users Guide is a brief explanation of some basic 
functions available to you on the website.  It is intended to provide you direction and 
insight, increasing your ability to utilize the tools available, enhancing your boat buying 
or selling experience. 
 
Please take some time to review this material, as it will assist in showing you around the 
site, and all it can do for you. 
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1. Log In  
 

Simply go to www.UsedBoats.com, once there click on the red ‘LOG IN’ tab (see 
Fig. 1)  
 

Fig. 1) 

 
 
Next enter in your USERNAME and PASSWORD, and hit enter or click on the 
Log In box (see Fig. 2).  This will open your Boat Central page. 
 

Fig. 2) 

 
 
 

2. Boat Central Page 
 

This is the homepage for your account, and provides you the ability to select all 
inventory management and review functions.   
 
Underneath the blue navigation bar you will see a grey WELCOME bar (see Fig. 
3) containing links to all your inventory management functions. 
 

Fig. 3)   



 
 
 

You will also see 7 grey panels containing information summarizing each content 
area.  Each panel has a link in red letters “View/Edit My Online Ads” that will 
also take you to your inventory management functions (see Fig. 4). 
 

Fig. 4) 

 
 
 
 
 

3. Place A New Ad 
 

This is the page to create your ad listing.  People search for used boats using 
many different criteria. Filling out the listing form as completely as possible will 
maximize the number of buyers who will see your ad (see Fig. 5). 
 
Fields that are highlighted in red are required.  If any of these are not completed, 
or do not match standard criteria, you will be prompted to verify or change the 
data.  Simply follow the steps, and prompts in each page, and you will be walked 
right through. 
 



Fig. 5) 

 
 
Note: You will be prompted to upload photos at the end of the ad-placement 
process. 

 



4. My Online Ads  
 

From the Boat Central, click ‘My Online Ads’, which is located in two different 
places on this page and displayed as in Figure 1.   
 
A list of your inventory will be displayed (see Fig. 6).  From here you can select 
several functions for your ads.  Select the ads you wish to affect, by checking the 
box to the left of the ad.   You can: Delete; Take Offline; Mark as Sold; View 
Emails; and Print My Ads, any ad or your entire inventory. 
 

Fig. 6) 

 
 
 
 
Ads can be displayed for preview by simply clicking any of the information in the 
line, of the boat you wish to view. 
  

5. My Offline Ads 
 

If, for some reason you do not want a boat to be displayed for a period of time, 
taking it Offline will do this for you.  Selecting My Offline Ads lists the ads 
currently not being displayed.  Any ads stored can be re-activated from this page. 
 

 
 

6. My Sold Ads 
 

Lists ads previously marked as Sold from your inventory. 
 



Note: When marking an ad as “Sold”, you will be prompted to indicate the most 
appropriate reason for the sale.  This information is collected for industry tracking 
purposes only and allows us to develop a more effective website.  
 
 
 

7. My Wish List 
 

You can create your own personal Search Agent to find a boat.  By identifying 
what kind of boat and features you want, the customized search agent will find it. 
Your search agent will check the listings every day and send you an e-mail when 
the boat is found. 
You can create as many different search agents as you want -- simply click the 
"Add a New Wish List" button and enter your criteria (see Fig.8) 
 

Fig.8) 

 
 

 



8. My Saved Boats 
 

My Saved Boats allows you to store boats from our database, for review and 
comparison, at a later time.  By utilizing the Compare and Value Analysis 
functions, when viewing ads, you can have all the information in front of you.  
There is no need to go back and forth between pages (see Fig. 9). 
 

Fig. 9) 

 
 
 



 
9. My Profile  

 
Information contained here is displayed as the Contact Information in each of 
your ads.  You can customize how this appears for each ad posted by making 
changes here.  From Boat Central Click the ‘My Profile’ link displayed (see Fig. 
10).  Make the appropriate changes and click the “Update My Profile” icon at the 
bottom.   

 
If you wish to make these changes to all of your posted ads click on the ‘Update 

Posted Ads’ Checkbox and then click submit (see fig. 11) 
 

Fig. 10) 
 

 
 
Fig. 11) 

 
 
 
 

10. Ad Manager File  
 

The Ad Manager file is displayed when an individual ad is selected for 
display from the My Online Ads page. You can make any changes to your 
ad including: modifying text, enhancing the ad for better viewing, adding 
photos or videos to the ad, changing posted photos or their display order, and 
previewing emails generated by the ad (see fig. 12). 

 
Fig. 12) 

When you have completed any changes, you must click the “Submit” tab at the bottom of 
the page.  Each time a change has been applied, it will display for review. 
 
 



11. Questions 
a. How do I update my Ad information? 
b. How do I Upload Boat Pictures? 
c. How do I change the order my ad photos appear? 
d. How do I change the Contact Information on my ads? 
e. How do I check my E-mails? 
f. How do I mark an ad as Sold? 
g. Why does my browser hang after clicking the ‘Upload Photos’ button? 
h. Where is my ad, I just did a search and I didn’t see it? 
i. How do I enhance my ad to help get more visibility? 

 
 

a) How do I update my Ad information? 
 

From the “Boat Central Page” select ‘My Online Ads’ and click the mfg/model 
description of your ad from the list.   Your ad will be displayed for review.  
Above your boat information you will see a red link in the AD MANAGER bar 
to ‘Modify My Ad’ (see Fig. 12).    This will bring you to the page where you will 
be able to make modifications to your ad.  From here make the appropriate 
changes and click the ‘Submit’ icon below. 

 
 

b) How do I upload Boat Pictures? 

 From the ‘My Online Ads’ page click the Mfg/Model for your boat.  Towards the 
top in the AD MANAGER bar (Fig. 12), select ‘Upload Photos & Media.’ Here you 
will be able to upload new images by clicking the browse button, and then 
browsing for the picture on your Hard Drive.  You will also be able to enter in 
a description of each picture.  When you are complete, click the 

 button.  You will then be 
returned to your ad displaying your images for review. 

 
c) How do I change the order my ad photos appear? 

 
 If you wish to change the order your photos appear, click the ‘My Media Files ’ 

link and this will take you to a page where you will be able to modify Image 
order and photo descriptions of each boat. 

 
 

d) How do I change the Contact Information on my Ads? 
  
 Changing contact information on your ad can be done in one of two ways.  If 

you would like to change information to a select number of boats, you can 
manually change the information by following the steps in How do I Modify 
My Ad? (Question a), and change the information in your contact fields. 

 
By selecting ‘My Profile’, and changing the appropriate information, select the 
checkbox to ”Update Posted Ads”   (see Fig. 11), and click the  “Update My 



Profile.”  This will Update all the ads that are associated with your account 
displaying the new information. 
 

e) How do I check my Emails? 
  

Emails from potential buyers are sent to the email address listed in “My 
Profile of your particular boat, unless you manually change it.  They are also 
logged for later review.  From the ‘My Online Ads’ page, select .  
This will open a new screen listing your logged emails in a line item 
description similar to most email browsers. 
 

f) How do I mark my boat as sold? 
 
 

 From the “Boat Central” page, select ‘My Online Ads’ and click the checkbox 
next to the appropriate ad in the list.  Click the  button found at 
both the top and bottom of the list on the page.  Your boat will no longer be 
displayed on UsedBoats.com, and will be stored in ‘My Sold Ads’.   

  
 To view your ad, select ‘My Sold Ads’ from the Boat Central page. Your boat 

will no longer be searchable.  However, if the Quick ID of your boat is 
entered for a search, it will be displayed as ‘Sold.’ 

 
g) Why does my browser hang after clicking the ‘Upload Photos’ Button?  

 
Common issues with hanging after attempting to upload media and material 
usually results from having a full Internet cache.  To clear your cache, follow 
the steps below. 

 
 

 Internet Explorer 
(1) On the Internet Explorer Tools menu, click Internet Options. The 

Internet Options box should open to the General tab. 
(2) On the General tab, in the Temporary Internet Files section, click the 

Delete Files button. This will delete all the files that are currently stored in 
your cache. Also Press Clear History and Delete Cookies as well.  All 
three of these may take a few moments to clear out so please be patient. 

(3) Click OK and your done. 
 

 Safari 
(1) Reset Safari:  

(a) This will erase your cookies, auto fills, cache, history list, usernames, 
and passwords.  
 

1. Go to the Safari menu  
2. Click Safari  



3. Select Reset Safari 
 

 Netscape 4.x and Up  
(1) Click Edit from the Netscape menu bar  
(2) Click Preferences from the Edit menu  
(3) Expand the Advanced menu by clicking the triangle sign  
(4) Click Cache 
(5) Click both the Clear Memory Cache and the Clear Disk Cache buttons.  

  
  
  

 
Mozilla 1.x and Up  
(1) Click Edit from the Mozilla menu bar  
(2) Click Preferences from the Edit menu  
(3) Expand the Advanced menu by clicking the plus sign  
(4) Click Cache  
(5) Click the Clear Cache button  

  
 
Opera  
(1) Click Edit from the Opera menu bar  
(2) Click Preferences from the File menu  
(3) Click the History and Cache menu  
(4) Click Cache  
(5) Click ok to close the Preferences menu  
(6) Please refer to the Opera support page on Web caching for more detailed 

information.   
 
AOL 3.x and Up  
(1) Please refer to the AOL support page on Web caching for more detailed 

information.  

 

 For Web TV Users: 
(1) Just unplug your unit from the power source and when you plug it back in, 

your cache has been cleared 

 
h) Where is my ad, I just did a search and I didn’t see it! 

 

 Searches for boats from the Find Your Boat section of the homepage 
can be very general, or very specific.  In each of these instances, there are 
several factors that may result in not spotting your ad. 

 



General searches typically retrieve larger numbers of boats from our database, 
while specific searches retrieve fewer.   
 
Because general searches retrieve larger numbers of boats from our database, 
yours may not be spotted easily.  Conversely, a specific, or advanced, search 
should be more limiting.  If the search criterion does not match the 
information posted in the ad however, it will be eliminated from the retrieval.  
Always make sure information contained in the ad is correct and accurate e.g., 
correct spelling, boat type and model classifications, etc.   

 
 
 

i) How do I enhance my ad to help get more visibility? 
 

 Usedboats.com offers optional features that will improve ad visibility by 
search list positioning, or ad text print. 

 
From the ‘My Online Ads’ page, select the boat that you would like to enhance.  
When you come to the page that displays your ad, select the ‘Enhancements’ 
link from the AD MANAGER.  This will display a page enabling you to select 
the enhancement options preferred.  Listed below is a brief description of how 
each of these features works.  After selecting the options that you would like, 

select the  button towards the bottom, and when you arrive 

at the next screen enter your credit card information. Press  
and you are done. 

 
 Featured Ad- This increases visibility of your ad up to 15x’s regular viewing 

activity by placing it on the front page of our website for 10 days.   
 
 

 High Priority- Gold or Silver priority options allow your ad to be displayed 
in the first or second position in any search list generated.  Our system sorts 
all search lists by length, and priorities are given within each length group.  
This feature increases ad visibility by up to 12x’s regular viewing activity. 

  
 Extra Visibility - This feature allows your ad to catch more attention in any 

search list due to the highlighted red or bold text.  Ads with this feature 
generally experience up to 8x’s regular viewing activity. 

 


